
MANUAL for e-Handbook

1 Quick tour of Windows, Menus and Tool Bars

The majority of the time in the fracture analysis is spend on the creation of input files. The e-Handbook of

Fracture is a Java based front end for the preparation of the input files (pre-processing). It also allows us

to run the Fortran program (main-processing) and read off stress intensity factors from crack tips present

(post-processing). The package is available for download at http://rci.rutgers.edu/∼denda/e-Handbook.

The instructions for installation to your computer and other pertinent information can be found at the web

site.

Figure 1 shows a snapshot of the initial appearance of the e-Handbook as you open the program. The

center blue piece of the e-Handbook is the Graphic Editor window, and to the left of it is the vertical Tool

Bar. At the top of the Graphic Editor window, where the Graphic Editor tab is placed, two more tabs

will be added later to display the input and output files. The Tool Bar contains several tools represented by

icons, which can be identified by hovering the mouse over them. These tools are grouped into pre-processing

(initialize, refine and edit) tools, main-processing (save and run) tools, and post-processing SIF tool. In

addition we find a Menu Bar on top, which contains standard Windows File functions and other items to

be described below.

1.1 Graphic Editor

Before the input file is created, the e-Handbook displays only one tab for the Graphic Editor. This is the

default window shown at the start of the e-Handbook. Horizontal and vertical rulers are shown by default

and can be switched on and off through Options menu using Show Ruler checkbox. The default Graphic

Editor curser is a cross hair sign (+), aided by a horizontal and a vertical lines through the curser for better

positioning of coordinates if the Show Ruler option is turned on. These two lines remain whether the ruler

is present or not.

1.2 Tool Bar

Items in the Tool Bar are arranged to follow the work flow of pre, main and post processings (Figure 2). The

Material Properties tool is a single member of the first group. The second group is the Element Creation

Group, containing the Add Boundary, Add Center Crack, Add Edge Crack, and Add Observation

Point tools. The third group has tools for modifying and fine-tuning the created elements, which includes

the Refine Element, Merge Boundary, Reverse/Delete Boundary and Edit Geometry tools. The

fourth group has tools for viewing the geometry, which includes the Pan, Zoom In, Zoom Out, and Zoom

Default tools. The fifth group has two tools, the Save tool to produce the input file and the Run tool to
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Figure 1: e-Handbook of Fracture startup with Graphic Editor window (center), Tool Bar (left) and Menu

bar (top).

2



Figure 2: Tool Bar

run the Fortran program. The last group has the Crack Tip Info tool, which is only accessible after the

Run tool is executed.

Although these tools are arranged in the order input files are prepared, there is no requirement to strictly

follow the order from the top to bottom. Once the coarse boundary is created either by creating a simple

boundary or through merging of multiple simple boundaries, it is advisable to use the Refine Element

tool to refine the mesh and apply the boundary conditions. The Edit Geometry Tool is used to modify

the coordinates of any of the boundary and cracks elements. For example, the kinked crack is produced

by moving the mid nodes out of the original straight alignment configuration with this tool. On the other

hand, the Run tool can be executed only after the input file is created, either by saving the current mesh

or loading an existing input file. Notice that the name of the current tool or instructions on how to use it is

shown in the Information Bar located under the tabs and above the blue Graphic Editor screen.

1.3 Menu Bar

The Menu Bar contains five menu items (Figure 3). The File menu contains the New, Save, Load and

Exit commands. Use the New command to delete the contents of the current Graphic Editor window to

start a new session. The Save command is used to save the contents of the current Graphic Editor into

an input file for the main-processing or to store the current mesh configuration to be completed later. If you

have an existing input file, then use the Load command to load the file into the e-Handbook; a contour with

the specified geometry and boundary condition will be drawn on the Graphic Window and the material

properties are loaded. The Load command is handy for checking the integrity of input file created manually

elsewhere.

The Options menu contains three checkboxes: Show Node Numbers, Show Ruler and Show All
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Figure 3: Menu Bar

Boundary Conditions. These checkboxes are on by default, but they may be turned off in case the

Graphic Editor will get too clustered. The Modification menu provides an alternative way to modify

the individual element that can also be performed by the Edit Geometry tool. While the latter relies

on mouse clicks the former primarily uses text input for specifying the nodal coordinates and double-node

properties of the elements. The user can also undo any unwanted modifications through the Undo Modify

Boundary and Undo Modify Crack commands.

The Characteristic Length menu is used to select the length scale of the problems. By selecting the

proper characteristic length suitable for each problem, we can deal with scales that ranges from nanometer

to kilometer. It is also possible to specify the custom characteristic length not listed in the selection. Notice

that the non-dimensional input data prepared by the e-Handbook is used by the main-processor and the

results are reported in the dimensional quantities using the relations (??). Input of the characteristic length

x0 makes this possible. If the characteristic length is not specified, then the input file is prepared with the

default characteristic length of 1 meter.

2 Input file preparation

2.1 Characteristic length

The characteristic length determines the appropriate length scale of the problem you are working with. Go

to the Characteristic Length menu and select an appropriate length scale for the problem. For example,

if you are dealing with a MEMS problem, then click the Micro radio button. If the problem is for the faults

in the ground, then click the geo radio button. Notice that the subsequent entry for the contour and crack

geometry is given in non-dimensional coordinates based on the selected characteristic length. Computation

is performed with non-dimensional variables and the final output is given in the dimensional form.

2.2 Material constants

The material constants are specified using the Material Properties tool located at the top of the Tool

Bar. Click the icon and a material selection window opens (Figure 4). Select the appropriate material from

the drop down list. Notice the values of compliances listed in the list are dimensional. The e-Handbook will

non-dimensionalize these constants by dividing them with s0 = 10−11(m2/N).

It is possible to input custom material constants not listed in the look up table. Edit the first two lines

in the Comments box: name of the material (first line) and the crystal class (second line), any text inserted
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Figure 4: Material Properties window

after the second line will simply be ignored when generating the input file. Edit the entries of the Material

Properties matrix (upper triangle only) to enter the custom values by double-clicking the desired cell. Make

sure you have typed in the proper dimension of the coefficients. For example, material constants for the

isotropic materials with Young’s modulus E and Poisson’s ratio ν are given by

Siso =
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Since the three characteristic roots Pα(α = 1, 2, 3) of the isotropic materials are equal to i =
√−1 (imaginary

number), the assumption of distinct roots are violated. All we have to do is to perturb the values of some

of the components in (1) to produce three distinct characteristic roots. Usually it is sufficient to change

the value of only one component to produce three distinct roots. We recommend perturbing s66 by 1%,

which can be accomplished by clicking the Perturb checkbox to have the data modified for you. Although

users can select any other custom perturbations, it is not recommended to perturb more than 1% of each

value. The similar perturbation is required for other anisotropic materials, such as transversally isotropic

(i.e., hexagonal) materials, for which the characteristic roots are also not distinct. If the final results, in

the Output Window, are in doubt, then check the characteristic values (or eigenvalues) printed in the
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Figure 5: Boundary Creation window

Output Window. If two or three characteristic roots are nearly identical, then try to increase the amount

of perturbation and retry the calculation with the new material constants.

2.3 Boundary geometry

Boundary Creation: For the simply connected region, the unmeshed boundary is introduced by the Add

Boundary tool in the Tool Bar (Figure 5). The e-Handbook generates a polygon enveloped either by a

circle or an ellipse. First select either the Circle or Ellipse radio button. If the Circle is selected, then

specify the Radius of Circle, the default is 10 in the unit specified as the characteristic length. For the

Ellipse, specify the Major Axis and Minor Axis. Next specify whether the created boundary will be an

External (counter-clockwise) or Internal (clockwise) boundary. Notice that the external boundary has the

counter-clockwise orientation. This orientation is reversed for the internal boundary. The orientations of

boundaries are reversible with the Reverse/Delete Boundary tool which will be described later. Next, for both

circle and ellipse, specify the Number of Elements, which is the number of edges used to create the polygon.

The default is 4 elements for creating a square. For Center of Contour specify x and y coordinates for the

center of the contour separated by a comma. The default is 0,0. Click Create to confirm the boundary

creation and close the window. Note that the contour geometry specified here can be modified using the

Modification menu or Edit Geometry tool in the Tool Bar, which also will be described later.

Mesh Refinement: The refinement of the contour by splitting is performed by the Refine Element tool
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in the Tool Bar. To initiate, click the tool button, then click the element to be divided. The user must

be careful not to click the tip of an element, for it brings about another function which will be covered

later. When a popup-menu appears, click the Two Segments menu item to have the element split into two

equal segments. Repeat this procedure until the whole contour is refined. An alternative way is to click

the Multiple Segments menu item when the popup-menu appears; enter the number of divisions you want

to divide the specific element into, click OK to finish.

Nodal Coordinate Modification: To modify the coordinates of any node (internal, external or crack element),

click the Edit Geometry tool icon in the Tool Bar and the cursor will turn to a cross hair. In the Graphic

Editor, left click and hold the mouse to drag a node (a red dot) to move it around and see the new position

of that node and the corresponding elements, release the mouse once you are satisfied with the geometry.

To make fine adjustment of the location of the node, right-click the node and left-click the pop-up menu

that appears as Set Coordinates. Type in the coordinates and click Enter to set the desired coordinate of

that specific node. Note that, the right-click of the node for setting nodal coordinates only works when the

cursor takes up a cross hair shape.

Double Node: To introduce double nodes, click Refine Element tool in the tool bar and the cursor will

turn into a hand. Left-click a node to call a popup-menu with two menu items, Double Node and Merge

Elements. Left-click Double Node to change that node into a double node. At each double node the nodal

point is shifted a small distance from the end point of the element. It is also possible to revert a double

node back to a single node by clicking a double node and selecting the Single Node menu item as long as

the Refine Element tool is active. The same outcome of turning a node into a double or back to a single

may be done through the Modification Menu’s Modify Boundary command.

Merge Elements: Suppose you want to eliminate a node and merge the two adjacent element, then use the

Refine Element tool in the Tool Bar. After setting the cursor to a hand, left-click a node to call the

Merge Elements command. Click the menu item to create an element that replaces the previous two elements

that meet at the node.

Merge Boundaries: Two boundaries can be merged together to form a composite shape. User should be

careful and follow the instruction given in the Information Bar right above the Graphic Editor window,

and carefully read the warnings (if any) that may show up. Click the Merge Boundary tool in the Tool

Bar to initiate the process. Then click any one of the boundaries you would like to merge, and then click

the second boundary to be merged with. The user must take precaution to ensure that the two merging

boundaries have two and only two intersection points, any more than two would result in a warning message

and the cancelation of the process. The orientations (clockwise or counter-clockwise) of the two boundaries

are arbitrary and do not affect the orientation of the composite boundary. After the two boundaries have

been chosen, all other unrelated boundaries will disappear for the rest of this merging process. Next, the

user needs to determine which segments of the intersected boundary contours to keep to achieve the desired

geometry. Once determined, click the two segments to keep. Notice that two segments need to be selected
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Figure 6: Add Center Crack window

among four possible segments. After two clicks, a dialog box will appear to ask for the orientation of the

newly formed composite boundary. Is anything goes wrong, then the process can be canceled anytime by

right-clicking the mouse, the boundaries will be restored to the original state.

2.4 Center Crack

Straight Center Crack: Use the Add Center Crack tool in the Tool Bar to add a straight center crack.

In the Add Center Crack window (Figure 6), specify the coordinates of the one end (x1 and y1) and

the other end (x2 and y2) of the center crack. Note that all coordinates and lengths are non-dimensional.

Click Enter to create the center crack. A red line in the window shows the newly created crack. Repeat the

procedure for multiple cracks. This process introduces a single straight crack element for each crack.

Mesh Refinement: To refine the crack elements click the Refine Element tool in the Tool Bar first. Next,

click a crack to refine in the Graphic Editor window. A popup-menu appears, click the Two Segments

menu item to split the crack into two elements. Repeat this procedure for each crack element to split further

into two equal elements. The progressive crack element refinement toward each crack tip is necessary for

accurate results. The optimum crack element configuration is show in Figure 7, where the size of the crack

tip element is c = 1/16 of the half crack length. To achieve this size, it is necessary to split the crack tip

five times in a row: first to spit the whole crack into two, second to split each of the two elements into

two, third to split each of the two crack tip elements into two, and so on. Only the elements located at the

crack tip need to be split. However, the use of a coarser crack tip element such as c = 1/4, which requires

three splitting for each crack tip, gives results accurate enough for most applications. There is no merge
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Figure 7: Crack elements for a center crack.

element option for the crack elements, if the you made a mistake, it can be corrected by the Undo Modify

Crack command in the Modification menu bar, or simply delete the entire crack by the Modify Crack

command, which is also under Modification menu bar.

Crack Shape Change: The method to change the size and shape of the crack is similar to that deployed for

the boundary geometry change. Click the Edit Geometry tool in the Tool Bar, make sure the shape of

the cursor is a cross hair. Left click and drag a crack node to move it to a new location. Right click on any

crack node to specify the exact coordinate of the node. We can use the right-click technique to specify the

coordinates of the nodes directly without click and drag. To introduce a kinked crack from a straight crack,

this technique may be utilized. Note that the click-drag and right click works differently under different

tools.

2.5 Edge Crack

Surface Breaking Point: The edge crack is introduced by the Add Edge Crack tool. After clicking the tool

icon, a warning window opens up indicating that no double node is present; please create one. If double

nodes are present, but they are not located for the prospective position of the surface breaking point of the

crack, then it is necessary to introduce a node first and then turn it into a double node. If the (single) node

is present at the surface breaking point, then simply turn it into a double node by Refine Element tool

and right clicking the node. If the surface breaking point is not a node, then use the Refine Element tool

to split the element into two to introduce a node at the surface breaking point and then make it a double

node by right clicking the node.

Straight Edge Crack: Go back to click the Add Edge Crack tool. In the Graphic Editor window, click

the double node at the surface breaking point of the edge crack. A window opens (Figure 8) requesting for

the coordinates of the edge crack tip, which is the end of the crack away from the surface breaking point.
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Figure 8: Add Edge Crack window
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Figure 9: Crack elements for an edge crack.

Input the coordinates and click Enter. A red line is drawn from the surface breaking point to the crack tip to

introduce the edge crack. The optimum crack element configuration for the straight edge crack is shown in

(Figure 9), where the size of the crack tip element is again c = 1/16 of the crack length. For the refinement

and modification of the edge crack, follow the procedure described for the center crack.

2.6 Boundary conditions

General Strategy: In general, each node has three traction and three displacement components. Due to the

displacement continuity, the end node of a continuous element has nine components: six traction (three

independent for each element) and three displacements (thee common for two elements). Any combinations

of the traction and displacement boundary conditions that leave three unknown components are acceptable.

For the double node, the situation is simpler since each node has total of six traction and displacement

components and allows three unknown components. When the displacement components are specified at the

double node, however, it is necessary to apply the same condition separately for each node.

Modifying Boundary Condition of a Single Element: Click Refine Element tool in the Tool Bar to initiate
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the process. Then click on an element so a popup menu appears. Click the last menu item, Modify Boundary

Conditions to open a window that says Boundary Conditions for Element *, where * is the element number. The

window has three sections separated into First Node: node #, Middle Node and Last Node: node ##, where #

and ## are the actual node numbers of the element. The left column of each section has three text-boxes for

x, y and z nodal values of either the Force (or traction) or Displacement. The selection of either the Force or

the Displacement boundary condition is made through the dropdown box in the right column. Select Show

Boundary Condition checkbox in the lower left corner to display the boundary conditions specified using arrows

for the traction and rollers for the displacement boundary conditions. The displacement boundary condition

for the x and y components are shown by the number indicating the magnitude enclosed by a triangle, while

a circle is used to indicate the z displacement component. Click Accept to accept the boundary condition

and close the window.

Multiple Boundary Condition Selection: Quite often, multiple elements have the same boundary condition,

so instead of specifying the boundary condition for each element, the user can select multiple elements and

specify the boundary condition once. To carry out this task, click the Refine Element tool in the Tool

bar. Left click and drag the mouse to draw a box that contains all the elements to be included. In order

for a particular element to be included its both end nodes must be contained in the box. If only one node of

an element is within the box, then it is not included in the list of elements. Once the desired elements are

selected, simply release the mouse to allow the Multiple Boundary Condition dialog box to show. This dialog

box is similar to that of the Single Boundary Condition dialog box except for the first section, which shows

the element numbers that have been selected for this session of boundary condition modification. Once the

desired boundaries are specified, click Accept to accept the changes and close the window. Also note that

this feature can also be used to delete the boundary conditions. Simply select the elements, when the dialog

box opens up, leave all the text-box values as the default value 0, click Accept to close the window.

Displacement Boundary Condition: Consider a continuous element E1 for which the end node A of this

element coincides with that of the adjacent element E2. If the displacement boundary condition is specified

at the end node A of E1, it is not necessary to specify the same condition for node A of the element E2.

Using the continuity condition, the displacement boundary condition of node A that belongs to the adjacent

element E2 is automatically set by the program. On the other hand, if the node is a double node, then the

user must specify the same displacement boundary condition twice for the two adjacent elements that share

the double node.

3 Observation points

If you want to calculate the displacement and traction in the post processing, click Add Observation

Point tool in the Tool Bar. In the Graphic Editor window, click the location for an observation point.

A window opens with the x and y coordinates of the clicked point. Modify if necessary. Input the angle of
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the segment over which the traction components are calculated in degrees. This angle is not the angle of

unit normal, rather it is the slope of the segment.

4 Create input file and Run the program

Save: To create the input file, either click Save in the Tool Bar or save through the File menu. A window

opens to prompt for the name of the input file and the location to save. After saving the input file, a new

window Input: ***.inp opens in the Edit Window which has now two window tabs, where ***.inp is the

input file name. (To go back to the Graphic Editor window, click the tab at the top of the Edit Window.)

Inspect the integrity of the input file. It is possible to edit the input file in this window. The edited input

file is saved to replace the original input file created by the e-Handbook when the user clicks the Run tool.

Run: In order to run the program, click the Run icon in the Tool Bar. A window opens up to prompt

for the name of the output file and the location to save it. After saving the output file, a window Output:

***.out opens in the Edit window which has now three window tabs, where ***.out stands for the output

file name. The output files lists the boundary displacement and traction, stress intensity factors at the crack

tips and the displacement and the traction at observation points.

Load: If you have an input file prepared manually or saved from other sessions, it is possible to load the file

using the Load command in the File menu. This will load the contour geometry as well as the boundary

conditions, observation points onto the Graphic Editor window. This is a great feature to test the integrity

of the input file prepared manually.

5 Get stress intensity factors

After running the program, come back to the Graphic Editor window, click the Crack Tip Info tool

which is the last icon in the Tool Bar. Click each crack tip and the stress intensity factors, KI , KII and

KIII will be listed in the Information Bar of the Edit Window located on the top of the window. Notice

that K-values listed are real dimensional values dependent on the applied load and the characteristic length

of the problem. For non-dimensional values, look for the output file in Output: ***.out window.
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